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MSOffice is great if you have it,
but | don’t want to neglect
the brave souls who downloaded
and use OpenOffice.org,

a terrific FREE alternative.
For the next few months,
look for detailed tips and tricks
on both, back to back.
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MSWord ... Tips & Tricks

Invisible Ink in MSWord ... MSWord has a feature that acts like invisible ink.
This is text you can see onscreen, but doesn’t appear on paper when you print.
This can be pretty useful if you have a document full of comments and notes you
wish to share, but print without the
personal notes. Here's how to make it
happen:

1. Highlight the text you want to
hide.

2. At the top of the main window,
click the word Format, then Font. Click
the Font tab and put a check mark next
to the word Hidden. You can choose
any color for your hidden text in this box
too. Click OK. You
should see your text
appear in your j at a jazz chab.
document with a dotted
underline. The dotted line beneath this
text is an indicator to let you know the
text is special and will not print with the
rest of the document.

the word Tools at the top of the main

: . and late night j cith
window, then Options. mh m‘ﬂﬁf&wu
4. Click the View tab and uncheck , piano, bass, percussion and female lead vocalists, an
the box next to the words Hidden text. blﬁrﬁzﬂm;ﬂ_mc:;ﬂ?mﬂ woukd
When the check mark is there, you can S S i

see your hidden text. When it is not, it is invisible. Now you see it...
There are other things you can
do from the View tab under Tools and Options. If
you have ever been plagued by extra formatting
markes in your documents, make sure there is no
check next to the word All. These marks don't
appear when you print, but they sure can be a
mystery for some, and unless you know how to get
rid of them, they can really cause some miserable
head scratching and wondering..

bh:eg,rmmdhlemght;am:m:nmupnﬂhl
an style. His arrangements combine fiddle, banjo, piano,
and female lead vocalists, and show how the hottest
mwwhpltyu]eufamesaugs in the wee hours at a
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prlfinl calae  all oo tha
Now you don't see it!

| For-Wayfaring-Strangers, -eliminate-the-specific
following - body-text:q
Formatting marks ... Click Tools and Options. Click

the View tab and uncheck next to the word All to get
rid of them.
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MSWord

Inserting Special Characters ... Everyone has had to face this at one time or another. You are right
in the middle of a document and need a special copyright (©) or trademark (™) sign. You draw a big fat
blank and waste a lot of time trying to remember how to jump through that special hoop to make it
happen on your page.

If you can remember the words, “Insert
Symbol,” It will be all over but the shouting.
1. Make sure your blinking cursor is
wherever you want the special character

(symbol) to appear.

2. Move the mouse pointer to the top of
the main MSWord window and click the
word Insert. A drop down menu will appear.
Click the word Symbol. A special Symbols
dialog box will appear with a few dozen
characters to choose from.

3. Select the one you want, and click
Insert.

There are two tabs in the Symbol dialog
box. The Symbols tab has a place to
choose which font (character set) you want.
When you find the symbol you want to use,
click it, then click the Insert button to close the box i
and return to your document. The Special Characters |
tab has a list of commonly used symbols, with
keyboard commands to the right of each. If you have
a character you want to use a lot (that isn’t already
listed), click it to select it in this tab, then click the
Auto Correct button at the bottom to assign a special
combination of letters to make it happen. You don't
need to remember keyboard commands or create
AutoCorrect entries. If you are comfortable enough
clicking the words Insert, Symbol, you can just
double click the symbol you need and it will instantly
be inserted where your blinking
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A paperless
office has about
as much chance
as a paperless
bathroom.

i “""':%" % cursor is. It's about the easiest

T .i thing to do, once you know how!
S Cusemssecsn Turning Word into a Personal Translator ... You don’t need to be a linguist to
(= Ente cooamnt translate a Word document or phrase into a foreign language or vice versa. It's a

teskupindifienary. |ittle known feature built right into MSWord. Word can translate a word, phrase or
ﬁm’,gﬂ &= an en_tire_ document for you with just a coup_le of mouse clicks. _
Highlight what you want to translate. Click the word Tools at the top of the main

3 atene fimersmnss. @ WiNDOW, then Language and Translate. Choose how you want to translate, and

hpsifen ek T click the Go button to see the resulting translation appear below. If you just want to
e translate a word, click the button next to the word Text and type in your word.
g crmenlir sy The first time you try this amazing little trick, you may be prompted to install the
Bt it files needed for this feature to work. Make sure you have your Office installation
m& CD \l/1vandy.
ool Lol ord Count ... Want to know exactly
R e por how many words you have written? How
wmenmeesieh L many pages, characters, paragraphs, and
& smsemsfmlant || lines are in your document? You may not

be a writer getting paid by the number of
words you write, but it can still be
interesting to view the statistics.
- Click the word Tools at the top of the
fabect s word i e Aents e main Word window. Then click the words
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OpenOffice.org ... Tips & Tricks

A printer consists
of three main
parts; the case,
the jammed paper
tray and the
blinking red light.

OpenOffice.org is a great FREE alternative to Microsoft’s Office offerings. It is a fully packed office
suite of programs and can be downloaded at http://openoffice.org. It is a hefty download (a little over 65
Mb) but certainly worth your time if you want to be able to open MSOffice documents sent by well
meaning friends, but don’t want to spend the $$ every year or so keeping up with the latest versions. It
includes a word processing component, presentation (like PowerPoint) package, spreadsheet and
drawing program. It is every bit as easy to learn and use as its expensive competitors. Visit the website
when you get a chance to learn more about it. You will have to keep reminding yourself it really is FREE!

Using Special Characters ... Using
special characters are just as easy in
OpenOffice.org. Make sure your cursor
is blinking where you want your little
copyright (©) sign or trademark(™)
symbol and click the word Insert at the
top of the main window. Click the words
Special Character and choose your
symbol. You can either double click the
special character you want (and it will
appear on your page), or you can click it
once to select it, then click the OK button
to cause it to appear on your page and
make the Special Characters dialog box go away. Personally, I'm a double clicker!

- Hiding Text ... Yes, you can hide text in OpenOffice.org, but the
steps are quite different from MSWord. Hidden text in
OpenOffice.org is treated like a special field that can be hidden
and will not print. To insert a hidden text field, click so your
blinking cursor is where you want to put it, then click the word
: Insert at the top of the main window, then the word Fields, then
Other. A special box will appear. Under the Functions tab, click
the words Hidden text or Hidden Paragraph. Type the text you
want to actually hide in the Hidden text box to the right. Click the
Insert button and the Close button to close the window. Your
-~ “hidden” text will appear on your document.
| This text should print, but the highlighted hidden text will not Click the word View at the top of the main window,
| Hidden text this is some hidden text then the word Fields in the drop down menu to see your
e e T e e v b Bl hidde_n te>_<t on the page. It will be highlighted so will be
[ no mistaking it. If you uncheck the word fields, your

hidden text will disappear (sort of). A little thin highlighted
line will appear to indicate something is
there.

Making PDF Files ... While
OpenOffice.org won't translate blocks of
text for you like MSWord will, it will do something MSWord won’t do. You can open
any Word document (even from the latest version) or create a new document in
OpenOffice.org and convert it to a pdf file for sharing with anyone who has the FREE Acrobat Reader. This
capability is built right into OpenOffice.org. Many other programs, including MSWord, require the full
version of Acrobat ($299 to $449) or some other third party solution in order to create pdf files. | don’t know
how OpenOffice.org did it, and | don’t care, but converting a document to a pdf file is as easy as clicking the
pdf converter button in the tool bar at the top of the main window, giving your pdf file a name, and telling the
file manager where you want to save it. This has got to be a sin, but one I'm sure many of you will be
grateful for. Itis just too easy. If you can open it in OpenOffice.org, you can make a pdf file!

Making Text Stand Out With Color ... There are several handy color tools in the OpenOffice.org toolbar.
Use them to change the color of selected text, highlight text or add a background color to a paragraph at a
time. Highlight the text you want to color, then click the tool button. Let your mouse pointer linger over each
button to see a description pop up.

From left to right, The A button is to change your Font color. Highlight the text you want to color, then
click and hold this button for just a second and choose a color. The color you choose will be available as a
single button click from then on. If you want to choose a different color, hold the button down again.

The middle button looks like a highlighter, and it is just that. When you hold this button down and
choose a color, it will highlight selected text the color you choose.

Click the button on the far right to choose a special background color for your paragraphs, or a single
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OpenOffice.org ...

paragraph. To add a background to several paragraphs, you will need to highlight them first.
If it is just a single paragraph, just click in it, then click the paragraph color button and choose
a color. It will automatically color the background of whatever single paragraph the blinking
cursor is in.

Wrapping Text Around Images ... This is one of the areas OpenOffice.org stands out
from other word processing programs. Once you bring an image into a document,
OpenOffice.org becomes more than just a word processor. It harnesses the power of DRAW
(the graphic editing portion of the OpenOffice.org suite), allowing you to do a lot more than just stick a
picture into your document.

There are a few ways you can insert an image into your document.
Click the word Insert at the top of the main window, then Graphics and
the words From File. Find the image file you want to use and double
click it to place it where the blinking cursor is. You can copy images
from other locations (like web pages) and paste them into a
document. There is also a Gallery button in the toolbar to help
you organize the images on your computer so you can browse
and drag and drop.

Once your image is in your document, right click on it to see other
available options. Click the word Anchor, then To Page. This will
allow you to left click and drag : o i

the image anywhere on the page. You can't do that in your A Life?
mother’s word processor! Cool!
Word Wrapping causes text to flow around the image. There Where can I
are several choices available, and they are “right click handy.” download one of
Right click your image again and click the word Wrap. There are those from?

lots of choices to experiment with here. No Wrap is just that. The
image will just sit there, hiding anything it is sitting on. Page
Wrap will cause any text behind it to wrap around the image
rectangle. Optimal Page Wrap seems to cause the text to
wrap on one side of the image. Wrap Through in
Background will put your image behind the text. This is
great for a quick watermark, especially since there is a
Transparency tool in the graphic toolbar (it will appear when
an image is selected). The Contour choice will cause text
to wrap tightly around the image itself. The program is

Transparency tool

. . *fﬁ#ﬂ*wﬁﬁﬂiﬂu“ B ﬁ"l‘"-."-"u"."‘" -
gmart enough to know where the actugl image outllne§ are | e e _} i P
(in most cases) and wraps around the image only. This :{%E::E.‘:‘i:;—ﬁ&_.r Wl o
eliminates the background part of the image and you won't | SEiin e VEEn SRnnns, S s

have a rectangle shape to your wrap. The better wrapping  [rsssss s e s @ v s
effects you can get, the less your image will look like a
postage stamp just stuck on the page.

Saving Word Documents in OpenOffice.org ... OpenOffice.org is very
compatible with Microsoft Office documents, including spreadsheets and
presentations. If your friends or colleagues don’t have OpenOffice.org, save
your documents in the format they need. It is as easy as clicking the word
File at the top of the main window and choosing Save As. If you take work
home with you, writing and editing documents and saving them in the
original format is very easy. No one will ever know you didn’t use Word!

If you're really sensitive and want to automatically save all your
OpenOffice Writer documents in Word format, click the word Tools at the top
of the main window, then Options. Click the
little + next to Load/Save on the left, then click
the word General. In the Standard file format
area, click Text document on the left, then
choose Microsoft Word on the right. Click the
OK button and all your documents will
automatically be saved in Word format.

Or you can leave things as they are and let
folks wonder what a .sxw file is. Itll serve em T oor
right! —
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WindowBIinas ...

A user friendly
computer first
requires a
friendly user.
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Have you ever noticed, when | use screenshots of various programs and steps
to illustrate and instruct, my computer windows don't look exactly like yours? | do
use Windows XP Pro, and out of the box it looks just like the XP Home Edition many
of you use. The reason my windows are more colorful and not likely to be the same
from issue to issue is because | like to Customize my desktop, and WindowBlinds is my tool of choice.

WindowBIlinds does much more than just change the way the windows on your computer screen and
programs look. It safely changes the look and feel of your entire Windows environment. One of my
favorite features is the ability to right click any title bar to make the entire window retract. It's sort of like
raising window blinds (hence the name). Another right click will cause your window to drop back down.
That is just the beginning of the “00’s and aah’s” you will notice when you start using them.

You will never be bored with a “Plain Jane” desktop again. There are thousands of WindowBlinds
themes to download and try for FREE. WindowBlinds is a free download, and once installed, you can
download and use themes until you are blue. You will need to purchase it and register to be able to fully
tweak it though.

WindowBlinds is really only the beginning. If you are really feeling frisky, love tweaking and want all
the bells and whistles, consider purchasing the full Object Desktop package. It comes with
WindowBlinds included, and many additional goodies to help tweak your windows and maintain your
system. You will wonder what in the world you ever did without them, and you will certainly never want to
see plain Windows ever again!

S

.:‘ Windows XP Themes, 5P Skins, 3 Yeual Stykes, Toons & Wallpapers for your I.H'hrrl.il:r.. Blinds Up
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Blinds Down

http://stardock.com
7.58 Mb download
Trial version is FREE for unlimited time. Enhanced version is $19.95.
Can also be purchased as part of Object Desktop Suite ($49.95).
Works with everything from Win98 to XP.
for more themes: http://wincustomize.com
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Tiny Treasures ... Domain Name Analyzer

http://www.domainpunch.com/products/dna/
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Have you ever wondered who owns some of those websites you visit? Is there more than what you
just see on their website? A good Whois lookup will tell you everything you need to know about the
person who actually owns the domain name. A great tool for looking up this information is Domain

Name Analyzer (DNA).

It is absolutely FREEWARE and a quick 668 Kb download. You can download an install file or a
plain .exe (runs on its own) file, but you must put the .exe file in its own folder after you download it.
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click the Top Level extension (.com, .net, etc) you
are interested in researching. Click the OK button
and you will see your domain names (or potential
domain names) in the top of the main window.
Right click each name and choose Check
Availability to begin the search. If there are many,
click the word Selections at the top of the main
window, then select all. When it is finished, you will
see the Whois information (if there is any) in the
bottom pane for each domain name. You will know
right away what is available and what is not.

If you see a domain name is taken, select it and
click the little globe in the top toolbar to visit the
website. Another way is to right click the name and
choose Browse Website. A browser window will
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DNA is a great tool if you are getting
ready to put a website up and need to
think of a potential domain name for your
product or business to register. Click the word
Names at the top of the main window, then
Construct Names. A small window will appear
where you can type keywords. Type what you
want for your main keyword or idea for your
domain name in the top box, then (if you wish)
type other keywords in the bottom two boxes.
When you are finished, click OK and watch it
present potential domain names for you.

Click the word Names, then Add names to
add current or potential domain names to look
up. The Domain Names window will appear.

As far as we know,
Type the name in the large box to the left and

our computer has
never had an
K@@  undetectederror.
L

nlyraly

|

™

Mhais Faiver Terslea [.]

DASALR RaBeS KA The ool sl .HaL doRAIRS CaR B D Ee@LINTATE]
with mamy diffarent compating registrarm. Go to BEEp /i intarsic. et
for detalled Enfsmwstion.

main Mlaps; PRECOCZARD COM

BegluLrar: TUCGHS INC.

Eholn Sarver) whols.opssmrs, st

Faferral UL Finps//domainbelp . tecom . oo
Habs Sarver: RS SOLYACTIVE. KET

S Srweps LT, POLYACTIVE, WEY

ELatuRs ACTIVE

Updabed Datar 19-aug-2004

Ereation Batei et =187

Explratisn Dite) Ob-se=e 3038

Theh praislabfy”

OF & o d &S 7 v L & 7 m s

BEAOEBE " ™ & By feman 8 Ugistal ok T L Vo
e m—r T E—
[a k] [F——— [ aoum, 1RuN Lm

oF T v, ek s

(w}] e L | T e, i

SIS ESrYer: WieLS.EFERLO.0EL. DORELN) EFEYLRATD . 00

= a

ey geewiaide [ Dewsmerd, 0 3 F b, ¥ avediafin

]

open and the site should appear if it is a valid
site. This can be very valuable if you are
considering a similar domain name (like using
.net or .org because the .com is already taken).
You need to consider what people might see if
they accidentally go to the wrong website.

This can be a valuable tool for hosting
companies and other businesses who need
help researching web domain names. Even a
casual Internet user can get a lot of use out of it
by looking up existing domain names to find
the whois information. It sure beats trying to
remember what website to go to when you
need to find out more about a domain name.
This little Treasure has it all built in!
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M. Weearas QUICKIIOS ..

-’} System Information ... Want to see a quick
' rundown on the current state of your
computer? System Information has the

]

. izrech: Window F Prefgsmcral
answers. Click the Start button, then All 51 2606 Sarece Fack I Buid 1500
. . R, Comangan
Programs, then Accessories. Move the i TRNGE
mouse pointer to System Tools and choose | ;. Mo
System Information. ﬁﬂ}gﬂi""‘“v
F1 ... Still as useful as it was in the old DOS Presri Tactveiuges 14 Ve 40P 6107

days of computing. Pressing the F1 key will
(in most programs) bring up the Help menu
for that program. If you press F1 while just
the Windows Desktop is showing, or when
a Windows Explorer window is open, the
main Windows help screen will appear.
You can learn a lot from this key.

‘o = "8 2500 2 10 by em 0408
Oasl |

Stay Up to Date ... Many software

* applications have a direct link to their website
in the Help area, if not a way to automatically
. check for updates. This insures you are

Bad or missing
mouse driver.
Spank the Cat?
[Y/N]

always working with the latest version of your
favorite software. Another easy way to check
for the latest and greatest versions is to visit
http://versiontracker.com. Just type the name
. of the software you want to check into the
search box at the top of the window and hit
the GO button. You will be presented with a
new web page with a direct link to download
the latest version. | found out about a new
version of IrfanView | wasn't even aware of.

=1 Neat!

# EMail Second Thoughts AOL ... Have you ever sent an email and
immediately wished you could unsend it? To Unsend an email in
AOL, click once on the Sent folder, then right click your email to see
your choices. Click Unsend. AOL sort of lets you unsend an email,
as long as you get to it quickly enough and before the recipient
opens it. When you click Unsend, it will disappear from the person’s
inbox. They will never see it. Once it is opened by the person you
sent it to though, it is history.

EMail Second Thoughts Outlook and Outlook Express ... Outlook
and Outlook Express both offer a way to not send your messages as
' soon as you hit the Send button. Your messages will sit in your
Outbox until the next time you hit the Send/Receive button.

To set it up in Outlook, click the word Tools, then Options, and the
Mail Setup tab. Uncheck
where it says Send
messages immediately when connected. You're not quite
finished though. Click the Send/Receive button directly to
the right and uncheck everything that has to do with sending
or receiving. This will give you total control over when your
email is actually sent.

If you don’t want Outlook Express to automatically send
your email, click the word Tools, then Options. Click the
Send tab and uncheck where it says Send messages
immediately. You might want to click the General tab too,
and uncheck where it says Check for messages every ?
minutes. This will keep sending and receiving totally in your
control. Whenever you want to do an email run, just click
the Send/Receive button at the top of the main email
window.

D:\PMaker\Newsletter\2005\march05.pmd
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Editor's Desk

This FREE newsletter is dedicated to taking the mystery out of computers in an
entertaining, informative way. If you have any questions or comments, please, drop me
a line, give me a call or email me and let me know what you think and would like to see
addressed in future issues. | really enjoy hearing from you and am happy to help. You
can receive e-mail notification when this electronic version of CompuQuickTips is ready
each month by visiting Mrs. Wizard’'s Web listed below. You will be able to receive it as a
pdf file in your browser or save it on your desktop. Download the latest version of Adobe
Acrobat Reader for FREE at http://www.adobe.com.

Help support CompuQuickTips by ordering Mrs. Wizard's CD Essentials when you
visit http://mrswizard.com. Look in the Special Offer section for more information and
other ways to help. Due to popular demand, the latest version of the CD has ALL the
past newsletter issues (since 1995). Acrobat Reader (the latest version) is on the CD
for you to install with one click of your mouse, as well as lots of Mrs. Wizard’s favorite
graphic shareware programs. This is a terrific learning tool! Just pop in the CD and
have fun!

If you want ALL the daily quick tips in one place, as well as lots and lots of custom
wallpapers for your desktop, think about joining the Happy Dragon Club at the
mrswizard.com website. A very small (one time) donation will get you access to a
growing number of Members Only goodies.

Sincerely,

%&/Z@Q ONea!
Nes
P

Mrs. Wizard’'s Webs
http://mrswizard.com
http://compuquicktips.com

In April ...

More on MSWord and OpenOffice.org
Letters & Envelopes
Watermarks

Your Personal Computer Tutor

Cindy O’Neal
1565 Wood Farms Drive
Cordova, TN 38016
901-753-6990 901-753-6039 (fax)
mrswizard@mrswizard.com

Mrs. Wizard's Web Design Team
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